ia can
Ndey Which Veto, the President of India €

e . .
PaBill for gn indefinite period?
(a)
S“S})ension Veto

b

(b) Absolyte Veto
© Regular Veto
(d) POcket VetO

Match List-1 with List-1I and select the correct

s : .
Wer using the code given below -

- Listx Listdl ©.. o
(A) Gedrosia 1. Herzit :
(B) Arachosia 2. Balochistan '
(©) Aria

3. Kabul Valley
(D) Paropamisadae 4. Kandhar
Code -

@ A-3), B-(1), C(2), D-(4)

(b) A-(2), B-(4), C-(1), D-(3)

© A-(1), B-(2), C-(a), D-(3)

(d) A-(4), B-(3), C-(1), D-(2)

- Who was the Commentator of Manusm‘riti?
(a) Mahadev

(b) Mahendra

(¢) Kulluk Bhatt

(d) Rakshif

- 'When did the Battle of Khanwa togk place?
(a) 16™ March, 1528 ‘

(b) 15% March, 1529

(c) 16™ March, 1527

(d) 15% March, 1527
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(b) qof ey

(©) Fraf drey

Ad) v ey
B S R R g T —

RY T g 1 T o WE v B
i

A1 1T
(A) TRy LR
C®)RPRE 2, e
(C) Tk 3. B B}
4. PER

(D) URfRE
BE -

(@ A-3), B-(1), C-(2), D-(4)
() A~(2), B-(4), C-(1), D-3).
() A-(1), B-(2), C-(4), D-3)
(@) A-(4), B-(3), C(1), D-(2)

. TR B IR BN -

(a) #geq
(b) 72— _

(©) Feegs e
(d) =fére /

A Gl T g B9 ga o

\)(16 W, 1528

(b) 15 #rd, 1529

19 169, 1527
(d) 15 911, 1527




e ¥ 5 L e

‘Grand Slam’ is related to which One among the
following games?

(@) Rugby

(®) Badminton

(€) Lawn Tennis

(d) Volleyball

Where is ‘Akbar’s Tomb’ located in India?
(a) Agra

(b) Gautambﬁddha Nagar

©) Prayagraj

(d) Ghaziabad

Who is the author of the book “Déughter of the
East™?

(8) Ms. Benazir Bhu‘ttol

(b) Ms. Sirimavo Bandaranaike
(€) Ms. Taslima Nasrin

(d) Ms. Aung San Suu Kyi

The book ‘Mnchchakanka” was wntten by -
(a) Shudraka
(b) Vikramaditya

(c) Banabhatta

(d) Kalhana

Which country won first T-20 Cricket World
Cup in 20077

(@) West Indies
(b) Australia

(c) India

(d) New Zealand

[C]

-

A R N
5.ﬁmﬁqﬁgﬁ@?ﬁ ’h%,
aftra 87
(a)"\"ﬂ'tﬁ
(b) AefA

(c)ar“ﬁm/

(d) dfeiarel

6. e # o P AP T Rorg

B ST
(b) TIAgE TR
(c) gAmIRIST
(d) TRFATSTE

7. e M T I B o ot g
(a)g&ﬁéﬁﬁ’r\’ﬂé\a
(b)géﬁﬁﬁrrra‘rﬂ-—@m
(c)g&ﬁﬁ‘ﬁﬁmmﬁ
(d)g%ﬁarmm:rﬁa%

8 e T s R oy 7 o

A 5

®) iy
(c) Eﬂvme—c-
(d) BRI

5. 2007 § fpg éw%rqam aﬂzoﬁﬁ)‘cﬁ?
BY e
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B R,

b UIDAI is a statutory authority establisheq ¢

issue ‘Aadhar’, UIDAI stands for -

(&) Bharat Udai Yojana

(b) Unique Integrated Development Authority of
India

13.

RIRUCIES Wmm%%?
Eﬁmﬁmm@mvr%uwﬁé‘mm ;?2;‘
e -
(a)ﬂﬂﬁmm
(b) v RRTE THIPT RERT ity

) U.mque Identification Authority of Indig ﬁﬂ?ﬁ’q fafire wgar wfEHw
(d) Unique Identification Data Authority of Indiy (d) e RAIRNE TET ST Wifdrvoy
14. Consider the following statements and select the 14, fymfeiRae el W AR AT w5 :ﬁ-,j R
correct answer from the code given below — Y e BT FAT B §Y WA TR i -
Assertion (A) - The Constitution of India e A), = WE\W eI @ g
CRGIR-1
rovides for a Federal Syst
2 b PR (R) — 01 TET FAG DT BT oy
Reason (R) It has created a very strong centre. ﬁ,—q-r 2
Code - e i
(@) (A) is true but (R) is false (a) (A) T ¥ W (R) Terd @
(%) Both (A) and (R) are true but (R) is ot  the \/(A) AR (R) A W E W (R), (A) #)
correct explanation of (A) g8l qreEn To '
() (A) is false but (R) is true : (c) (A) TeTd ? A (R) 'ﬂ?f 2
(d) Both (A) and (R) are true and (R) is correct (d) (A) 3R (R) 3 & & T (R), (A) B
explanation of (A). E et ©
15. The cyclone ‘Biparjoy’ is related to which Sea?  15. ‘RuRwifa’ Tshard il TR b AR ¥ &2
(@) Arabian Sea Ma) IRT 9N ‘
(b) Indian Ocean - (b) fET HerR
(c) Black Sea (€) T R
(d) Yellow Sea (d) Gre IR v
16. Leaching of soil is related to - 16. Y o7 e waf % -
(@) Black soil - (@) Hreht
(b) Laterite soil - (b) SRXNT3T Sy
~ (©) Alluvial soil (c) Sietie ) -
(d) Red soil (d) e g
17. Which among 22 33 66 and 1212 is the largest 17. 22 33 66 o) 1212 L ﬁ ?Tél'ﬁ EAEe:) % -
number?
(@ 123 @ 1;2-“ ‘
b) o
(b) 25 it
(c) 6% ‘ ('.:),6:
d —-—
d) 33 . . (d) 33'
[C] Page 5 of 32



18,

19,

IFsc stands for -

@ Indian Financial System Code

(b) Indian Financial Service Code

(©) Indjan Financial System Corporation
@) Indian Financial Service Corporation

NASSCOM is an Indian non- -profit, Non-

G‘)Vemmental Trade Association, ‘focused

mainly on the Technology Industry of India.

NASSCOM stands for -

(@) National Association of Software and Serv1ce
Corporations '

\)b) National Association of System and Software

20.

Companies

(¢) National Association of Software and
Security Companies

(d) National Association of Software and Service

Companies
‘FEMA’ stands for - , ‘
(8) Fund Exchange Management Act, 1999 -
(b) Fund Exit Management Act, 1999
(c) Foreign Exit Management Act 1999
(d) Foreign Exchange Management Act, 1999

18. s o, @ ol B R -
(a) 3Ry wAfaTe Ry o
AL 377 wrgafre afdw sis
(¢) SRz wgAfarTe Rived PRuier
() 3Rz wrgmferer Wi Bivorgy

.‘9-%#Wwﬂﬂ?ﬂuﬁ?w;ﬁy\ﬂ

wﬁa%,‘vrﬁg@wﬁwa%ma
SET T B &1 AW B
(a)_ﬁwmﬁ?wmmﬁ%%md@:

(b) et Teiftieer s Rived vs i
BRI '

BUEREC IR i R R .
(d) el THIRTTE o wiveday ve ¥
20. vh gy, (@) B o g -
(@ 5 v e e 1099
_ (b)m’qﬁmeﬂﬁmﬁem 1999
(©) BRT Tfasie Forie wae 1999
Jwﬁwmﬁﬁmﬁew 1999 -

21. SpeedofAistwicethatofB'andspeedofB'is 21 A P AT B e ?ﬁ'rfﬁ T B @l *
thrice that of C. If C covers a distance in C @ el & farrh &) af o 0 @
48 minutes, the same distance wil] be covered by : 48 firre 3 PG % ar g {ﬁB fora |
B in how much time? -1 T BT
(a) 18 minutes. (@) 18 fime .
(b) 12 minutes (b) 12 fiFe
(¢) 16 minutes (©) 16 fFe
(d) 14 minutes : (d) 14 fFre
22. Who inaugurated new Parliament Hoyge’ of 22 ¥yRrg B T HHE W BT Sgared fa
India? ,  fpar?
(@) Speaker of Lok Sabha @) < e Ry
(b) Prime Minister of India /b) A -
(¢) Home Minister of India
: /e (€) Ra & T[EEA
(d) President of India
| - (d) YR B gy
C] '~ Page 6 of 32
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23.

Which one of the following statement is Correct  23. -@)a B < EATE W mm 3
with reference to the author of “Straight from the & m' 3 Praferflad CRICR ?ﬁ‘hm
Heart : An Autobiography™?
1. Sachin Tendulkar 1. WferT AgePR
2. Kapil Dev | 2. Hfer 29
::ll::: :the correct answer using the code given 43 R ™y e & wE IR B g -
(a) Only 1 (a) daat 1
(b) Neither 1 nor 2 (b) 7 a 177 & 2
(¢) Both 1 and 2 () 18R 2 3
(d) Only 2 ; A HIT 2
24. Which river of India pa_isses the Tropic of Cancer  24. g P PIFA &) FP Y& ¥ TV IR
twice? (s :
(@) Narmada - (a) T
- (b) Sabarmati (b) e
- (c) Mahi TS
(d) Luni .3 . \‘/:)) G4l
2>-Match - Listl (lnventions) with —Listl 25 qi-1 (rfim) @ G- (e
(Inventors) and select the correct answer from . Wﬁ BTy Gﬁ_\’ A fag we ﬁ‘ Al
the code given below - : RUEN m
List-I s '
(A) Cosmic rays (A) Pif faeot
"~ (B) X-rays . ®) X’w
; (C) Radioactivity (C)Am wfsaa :
(D) Artificial radioactivity - (D) Pm XA Ffpaar
List-II -0
1. L Curie & F. Joliot L. 3. & T4 1. Siiferre
2. Viét_or Hess 2. Raer 29
3. W.C. Roentgen 3. S, AWeoiH
4. Henri Becquerel 4.8 PR .
Code - v o — :
(a) A-(2), B-(3), C-(4), D-(1) (a) A-(2); B-(3), C-(4), D(1)
(b) A-(4), B-(3), C(1), D-(2) (b) A-(4), B-(3), C-(1), D-(2)
(¢) A-(2), B-(4), C-(1), D-(3) A A-(2), B-(4), C-(1), D-(3)
(d) A-(1), B-(3), C-(2), D-(4) () A1), B-(3), C-(2), D-(4)
[C] Page 7 of 32




. Consider e following statements

27.

-

[C]

with

reference to the Konark Sun Temple =

(1) It is also referred to as the Black Pagoda.
(2) It was built by King Narasimhadeva I
(3) It is a UNESCO World Heritage Site.

Which of the statements given above are correct?

(a) 2 and 3 only . C)
(®) 1 and 2 only gg
() 1 and 3 only ?E)
(9 1,2 and 3 o
On which date ‘World Youth Skills Day’ is
celebrated? .
(@) 15 August -
(®) 15 July ‘ C‘Q)
(€) 15 March 3 08
(d) 26 January &
Chandrayaan - 3 : India’s Mission to Soft — Land

on the Moon’s South Pole was launched on
which date?

(a) 14 July, 2023
(b) 14 June, 2023
(c) 15 July, 2023
(d) 16 July, 2023

. Which one of the following pairs is not correctly

matched in terms of the power of the Presides
of India to make Regulation for certajn Ungzi
Territories under Article 240 of the Ind%ﬂ
Constitution? )
(a) 240 (1)(c) - Puducherry

(b) 240 (1)(b) - Lakshadweep

(¢) 240 (1)(d) - Daman and Diu

(d) 240 (1)(2) - Andaman and Nicobar Is|ands

\

-

2. ot gt AR D T ¥ P
R R & - 3_
(1) 30 A YT A BT W B 1
@ e e T TR 343

o |
(3) 78 T 1 TF fA99 SRR wopg 4,
R A T wuE A BPTAEH
(a) Bgat 2 3R 3
YT dae 1 ek 2
(c) Bact 1 3R 3
(d) 1,23k 3 ,»

27. fyvg gar PR Raw v R o T am |
2?
(a) 15 3Tt

s o

“(c) 15 |

28.
AR B farg e B e e fafdy @ W

(d) 26 ST
A — 3 gl B Rell-gd R 6T

f&ar T or?

‘/{)/(4 s, 2023

29.

) 14 S, 2023

(€).15 s, 2023

(d) 16 TS, 2023
qwaz%vﬁm‘cﬁaaﬁﬁmoa‘»m@

|y o &9 @ fw ﬁﬁmaﬂﬁiﬁ“@ﬁ
o TR B T A e A @ W I
gafera 8 87

(a) 240 (1)(c) - Tgo

(b) 240 (1)(b) - TETEY

(¢) 240 (1)(d) - T 3R <ra ./

(d) 240 (1)(a) - 39 TG fr@ER &9

Page 8 of 32
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30.

31.

32

33.

‘MOM’ also known as Mangalyaan, is 5 Space
mission launched by the Indian Spaée Research,
Organisation. Its objective is to explore Marg
surface features, morphology, Mineralogy &
martian atmosphere. What does ‘MOM? stand

for?

(@) Mission Orbit Mars

(b) Mars Orbiter Mission

(¢) Mars Orbiting Mission

(d) Mission of Mars .

Who is the first Indian woman to win an Asian
Game gold in 400 meter race?

(a) Manpreet Singh '

(b) Sania Mirza

(c) Kamaljeet Sandhu

(d) P.T. Usha

- ‘Thomas Cup’ is related to which one among the -

following ggmes?
(a) Badminton
(b) Hockey-

(¢) Volleyball
(d) Cricket

Right to Information Act, 2005 primarily helps

the cause of -

' (8) Social Integrity

(b) Legal Reform
(¢) Transparent Administration

(d) Political Reforms

]

v——'——
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(c) wrd SifffET forer
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34,

Match Ligt-1 with List-11 and select the correct

answer using the code given below the lists -

List-1 List-11

(Writer) (Books)
(A) Yashpal 1. Tamas
(B) Kamleshwar 2. Meri Teri Uski Baat
(C) Bhisham Sahni 3. Mujhe Chaand Chahiye

(D) Surendra Verma 4. Kitne Pakistan
Code -

(8) A-(3), B-(2), C-(4), D-(1)

(b) A-(4), B-(3), C-(2), D-(1)

(©) A-(2), B-(4), C-(1), D-(3)

(d) A-(1), B-(2), C-(3), D-(4)

34,

-1 Y -1 < AR BIRIQ e e

B 9 Ry Bre F T TR B AT -
' w_[ qﬂ’f—l[

(o) (forem)
(A) Trerarer 1. @Hd
(B) ®HHAITIR 2. 99 R I 9T
© s e\ 3. 79 A afgy
(D) g g foper i
a{a_

(a) A-(3), B-(2), C-(4), D-(1)

- _Ab) A-(4), B-(3), C-(2), D-(1)

(c) A-(2), B-(4), C-(1), D-(3)
(d) A-(1), B-(2), C-(3), D-(4)

35. When the sun is near the horizon during the  35. e T UM & a9 99 RO @i @ o™
morning or evening, it appears reddish. The e 2 3' SferArgad woid 81T 21 39
phenomenon that _is responsible for - this IaeiteT @ g RreRR aReeT & —
observation is -

(a) Reflection of light PRI AR .
(b) Scattering of light (l.,) FET P o (H3)
(c) Refraction of light (€) TR BT S

(d) Dispersion of light ‘(d) ST T TR0

38. The disease rickets develops in children due to . 36 g=a} 3 & AT fEEa FH & RO Bar 22

the deficiency of - ' \}) AT B
- (@) Vitamin B § e D/
- Vwamm P (¢) faerfim C
(¢) Vitamin C
- (d) Vitamin A (d) 13T A

37. A person bought an article for 784 which 37. vs a&fdd 7 & T 78R H ), R 12%
included GST of 12%. What is the price of the LCHEL. e o | Mead. ey ¥ T
article before GST was added? IE] DT oI 1 Aq1?

(a) T 690 (@) 6903

(b) T 695 (b) 695 Z

(c) T 685 (c) 685%

(d) 700 (d) 700
[C] Page 10 of 32
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: 3l
38. Which Article of the Indian Constitution deals  38. sy wfaET & DI WY “Wlﬂi;\rm

\lrvith the suability of the State of India? i Gl aﬁ—m i wiaferct &
(@) Article 300 | (a) argas 300
(b) Article 330 ' (b) 3P0 330
(€) Article 200 ‘ \/m’ s 200
(d) Article 100 ‘ (d) argeoe 100 4

39. What was the main reason behind Moplah ~ 39. 192] % Aven fA&TE BT T DRV T o1
Rebellion in 19217 (D) et T SR @1 IR |
(I) Exploitation of Moplah’s by Zamindars. : £
{m Bfitish Govemme:t policies against (ID) 3fiot FAR @) W o]

Khilafat. e : ?ﬁ%f?ﬁ'a@ﬁﬁgfwﬂﬁ?—

Select the correct answer usiqg the code givén e ~
below — 2T T e
M : (a) TT 179 10
(a) Both I and II | } . ®FdIman .
(b) Neither Inor T (©) a\,—qa I
() Only I . |
(d) Only I N gl

40. Where is ‘Golconda Fort’ located in India? . 40. “Treiarier ferr aRT % Bet Reg 82

| (5)'Telangana | ‘ L/(.a‘)’ﬁ?ﬂTnﬂT -
(b) Punjab (b) 4oirg
(c) Delhi (c) feeeh
(d) Rajasthan (d) "o

#1- By which one of the following Amendments the 41 P # ¥ Rt v weier & grer e )
Lok Sabha seats were raised from 525 to 5457 IS 5259 545 QIS TE?
(a) 31 Amendment . (a) 3197 wHeles %
(b) 42" Amendment (b) 425 T -
(¢) 56" Amendment ¥ 563t e
(d) 35 Amendment (d) 3557 el

[C] Page 11 of 32
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[C]

Frefere 3 ¥ faerer il freet fovem e 22

2 Which one of the following i correctly 42,
Matched? -1 T -1
List-I List-I (Rema) (es)
(Book) (Author) (@) e : g A - XT FAR
(@) Jugalbandi:The - Ravish Kumar & fRer 9@
BJP Before Modi , (b) SRRT MR : TRE - TINARI WEA
(b) Indira Gandhi : - Nayantara g TR |
Tryst with Power Sahgal ' (©) =6 o ES - Hed a®
(6) HalfLion:How - Sanjay Baru A
P.V. Narsimha Rao EE e
Transformed India W ikl
: . d T sfeara: - 8 g TuE
(d) The India Way : - Shri ( "
Strategies for an Dharmendra Seoolld BR T -
Uncertain World Pradhan . HTHST TS
43. Given below are two statements, one is labelled  43. 1 3 wer Ry 7y &, R Ta @ e
as Assertion (A) and other as-Reason (R) — (A) 3R TR BT FROT (R) HET 4T g
Assertion (A) : The idea of the name of Pakistan AP (A) : UIfbE & M P faER &
was suggested by Rahmat Ali. ' _ SEIERGLG arel) 3 2y o
.Reason (R) : Rahmat Ali publishedabook ‘Now WUT (R) : <&wd ol =1 1933 % ‘apfi & G|
orcher’ in 1933. : T8 THE W’ gpIRE @7 off |
Select the correct answer using the code .given A m Tq T J Hé‘r IR P ﬂﬁ(’ i
below :
g;’de' J/(A)m%% (R) TereT &
: (A) is true but (R) is false (b) (A) 3R (R) N % R), (A) ﬁ it
(b) Both (A) and (R) are ‘true but (R) is not the Pl s ' o
correct explanation of (A)
_ (c) (A) is false but (R) is true () (A) TTer]. e W (R, %
(d) Beith. (A) and (R) are true and (R) is the . @@ e @) < e € AR (R), (A) B T
correct explanation of (A) e &
- Arrange the following stages in the Enactment of 44 uTe GTW @ ﬁﬁm Wﬁ B e W
Budget in proper order - # ¥R -
(1) General discussion (1) JH 989
(2) Appropriation Bill 2) fafrarT faes
(3) Finance Bill (3) a1 faerass
(4) Voting of the demands for grant. (4) ™ A W FISH
(5) Presentation to Legislature (5) faenfare P TRHIOT
(@) 5,1,4,2,3 (@) 5,1,4,2,3
() 1,2,3,4,5 (b)1,2,3,4,5
(¢) 5,1,4,3,2 (¢)5,1,4,3,2"
d)5,1,3,4.2 (d35,1,3,4,2
Page 12 of 32
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* India g Situated o Which place iy,
Freedom 1dey .

20237 World Preg
(@) 135
(b) 14
(©) 161
(@) 134
6. What ig the appro

the Bartly'g Crust';mmale Percentage of carpgy, i,
(@ 0.015¢,

(b) 0.005¢,

(© 0.0250,

Ad) 0.0459,

47. Which one of the following acid ig éécreted by

leaves of Nettle that causes painful stings?

(@) Citric acig
(b) Tartaric acid
(©) Acetic acid
(d) Methanoic acid
8. Which one from the following is the highest
point in Uttar Pradesh?
Kaimur hills

) Amsot peak

(c) Sonpar hills
- {d) None of the above

49. Who among the. following is an International

shooting player?
(3) Anjum Moudgil
(b) Manju Rani

(c) L. Sarita Devi
(d) Jamuna Boro

S0- If 10 men or 20 boys can make 260 mats in
20 days, then how many mats will be made by

ﬂa‘s‘wmﬁ a‘fgmgﬁqga@,‘cﬁﬁﬂﬁ

8 men and 8 boys in 20 days? 20 1 ¥ foparesy erd o

(@) 260 (a) 260 -

(b) 312 (b) 312

(c) 286 (c) 286

(d) 280 (d) 280

. o
[ -

~ 48.

45. WWWW-&**W%
A WE R 87
(a) 135

Ab) 141
(c) 161

(a') 0.015%
(b) 0.005%
"{) 0.025%
(d) 0.045% ; ,
Y. Prerfofea # & B o 18 e
BT PR BT R -
. (a) il &S
: TRERP apa
\/::; R g

@ 49 o
49. 'ﬁmﬁ-ﬁﬁaﬁqm@jeﬁﬁm
€7 .
(@) 3 Hrafrg
(0) T 3t
(©) vor. aRar a4y
°0 IR 10 A sperr 20 wrgd 20 Rt # 260
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58. iﬁh—lmtﬁr—llﬁgﬁmﬁmaﬁwaﬂﬁwﬁ@ﬁwqﬁ?—
-1 -1

A. IR 1. 3
B. &Y 2. AT
C. & 3. fqure
D. @R’r ' 4, YTl
.ﬁr 3 A - i i
(@  (A)2, (B)-3, (04, (D) C®) (AL (B4, (02, (D)3
© (A3, (B)2, (O], (D)4 d (A4, (B)3,(C)2, (D)-1
59. ‘T o7 fa@m § —
(@) fa=ivl A \/({) CEaL
© oy 7 @) - et
60. fyiferRae ¥ & & A9 AYE T — ’ :
(@)  H W HT AW T ‘ M) iR R PR R
© wTEovETEdaATl (d) _agaﬁmﬁ‘rq?@ﬂﬁ?ﬁl
61. Wwﬁ'\ﬁmﬁuﬁﬁmmﬁé SH FEA B —
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\J;)/ am_ﬁ?l:ﬂ : . (d) 5 Ghll
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: | -
(T wrez)
(1) T
(2) FAER
(3) B
(4) 3T
@  A-(3),B-@),C-(1),D-2) «AB) - A-(3),B-(1), C-(4), D-(2)
()  A-(4),B-(3),C-(1),D-(2) : d A1), B-(3), C-(2), D-(4)
63. ﬁwﬁﬁaﬁﬁmﬁﬁﬁmmﬁm%— ¥ .
(@) oA & 6T 3MuHT aH fAe | (b) A ARG MUHT gH BT |
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73. ‘FOLLOW-UP’ SISl ¥ o7 e Rt aref wfirg — X B
(@ oRad e ) e
74 oF ¥ T TR F G A B gl By way ¥ - : -4
(a) -. | (b) fewur 5
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1. "fEIROT &1 3o v § —

(@  Approval \/('b{ Disposa]'
(©)  Occupation (d)  Sanction
78. 'qEY ST TARIERN BT UK 27
a) Tyl (b) o
() A (d) ﬁ‘:ﬁﬂ.\/
79. ‘qId & G H IR P 3 ® —
B GRS BT gasT Bl (b) g FA
© 359 fog @ | Cﬁ(d) arferefrer |
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T BT g1 PIY —
1. ¥
2. A -
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@ 1,2 ' : 'm(b) 2.4
173 @ 23
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A T o) ffe
€ e ' @) e
&ﬁwfsmaﬁﬁv@rmgﬁq—, e
J8) - S Taw 5§ =R a4 § Le) (b) - S g b ¥ TR i ¥
© ST fFeaRaEE| %(d) ISARERICIRGAR e R R

'u.@gf@_nawwimmﬁ@wmﬁmwﬁgﬁq_

=) (wafa)
A g 1 Wﬁ
'B. affi®
C. 347 3 RGN
D. &Rl 4, 3R
s J6&, i _
, )
@ (A1, (B)-2 (C)3, D)4 "ﬁﬂ> (A)-4, B)-1, (C)-2, (D)-3
. & :
(©  (A)2,(B)-3,(C)4, (D)1 te @ (A-4,3)3, 01, D)2
85. ‘agRere’ @1 afeh ¥ wEr o — | |
(@ Postpone b) PO]YPloidy
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86. - h AN
@  wd | N TR |
(C) 'lﬂ?-[ (d) 3!-@- )
87‘W—Iﬁﬁ—ﬂﬁwwmm*%mWaﬁﬁﬁww_
-1 -1 '

A. Record 1. T
B. Tension : 2. e
C. Sample : 3, dq1d

D. Uncertain 4. srfaf¥ad

- 1§

@  (A)-2,(B)3,(C)-4, D)1 (b) - (A)-1, (B)-2, (C)-4, (D)-3

MO ()2, B)3, O, D14 L@ (A1, (B4 ()3, D)2
g W—IQW—HﬁWWWﬁmWWWWWWWW_

-1 _. -1
(EF® ) (T =)

(A) Ir=AT asﬁarz»ﬂ : (D) @reEr

(B) B AT — O RIEE

(C) @™ AT — 3) fazaag

(D) fazara & urg 4) U

(@  A-(3), B-(1),C-(2), D-(4). U A-(2), B-(4), C-(1), D-(3)
© A1), B-(4),C-(2), D-(3) | © (d)  A-(4), B-(2), C-(1), D-(3)

89. qﬁwa?aﬁﬁ?ﬂﬁﬁqwﬁmmmﬁﬁmﬁﬁﬁ?—wwﬂﬁﬁ? :
(1) TP T WHR BT 13
\/(Z)qﬂawa%mqamﬁqa
_AB) ITH 59 PRI Y O
(4)ﬁﬁ¢rqm$qasmaﬁqg

\,(a/ MO L m @dRE)

© .3 ' & @ (3) 3R @)
-90. ' T BT AFUSH e gy — : PoEAON
( a) Invoke ; (b) Inward
(c) Invoice (d Invite
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(a) g Pl ) e
frard . (d e
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92. Raftre arger W faRme At @ e R T Rgargel Ao caIoll

(@) I A arfawmeT
(€) 3w (d)  wEoT
93. ' B Rem 2 -
(a) IR (b) foeT
© PR | S R
9. A1 B AT W A AR o A Ry g e 1 T AR FE SR G~
-1 -1 '
@ & =) (it # aref)
A TSt | 1. Country
B. 3 2. Cottage
C.HdEH 3. Control
D. Fa=o 4, Captain
@ (A1, (B)2 (03, D)4 - (b (A)4, (B)-2, (O)-1, (D)-3
©  (A)3,(B)1(C)2, (D)4 O @2,@) (C)-4, (D)-3
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(© 9T R @M FAT Y wﬁwm |
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9. NP F ST E( 56 aw F wek orf ¥

@ g \_,(D«)/ FE

(c) Rk : (d) ’5?!72?@'[
9. ‘fffay v & forg g B — - '
\/(ﬁ)/ ERIREED AIPIY iy b) Y ﬂﬁs‘ T

(© T B AMBR TE B (d) m.mﬁm\’?ﬂﬁm
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........ e iiviiieieeseew key is used to create

10l g, o€ (MS Word) & =€ sm & g

chart is MS Word. . @Ol (key) BT TINT fbam Siwn
(@) F7 2|

(b) Fi @) F7

e ‘ ®) F11

(d) Fs o PLED

i (Y RS

» Which of the following is the keyboard shortcut 102. i wise ¥ TR @R ISR T P

3 fre frefaRen. S widse (keyboard
shortcut) ¥ SR 20 e

to start the Power Point presentation from
current slide?

(b) F5 | L\QFS -
©) ALT +F5. . (©) ALT +F5

3. Which command should you use to zoom to 'see

103. Qsﬁ'@r (Adobe) 81w, v B wﬁ frRi

~all edges of an Adobe PDF document" ' B e $ forg SH B B farg MTW &g

(a) View > Fit v1s1b1e , TS BT ST Hee ARy?
(®) View > Fit width _ (a) View > Fit visible
; (b) View > Fit width
(¢) View > Fit page 5o View > Fit page
(d) None of the abov'fa : ' () SR ¥ X P T
04. The tool using’ which predefined actions whj-ch, 194' 98 JUSRT (&) W {éﬁm’rﬁa foramett @
can automate tasks on an MS Access report is . EERIL W'Q‘TW TR (MS Access) Rard
“alled : e Wiﬁlﬁﬁmﬁﬁfﬂm% .........................
’ : , . FEART R
~ (a) Macros , 4 g N
- (b) Tgble by ey
(c) Form (c) th*'rﬁr ;
© (d) Fields e @
EEE Page 20 of 32
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105. Which of these are hardware components of a
computei‘ system?
@) Input device
(i)
(1i1)
(iv)  Central Processing Unit
@) (i), (i), (iv)
(b) (i), (iii), (iv)
(©) (i), (i), (iii)
@) (i), iii), (iv)

Output device

Device driver

106. 1 MS Excel, concatenation of text can be dohe
using --
(@) Exclamation (!)
(b) Hash (#)
(¢) Apostrophe (')

(d) Ampersand (&)

107. Which feature of Microsoft Word helps in
creating list?-
(@) Word Wrap

(b) Bullets énd Numbering
(©) Scaling .~
(d) None of th;e above
108. What i the correct location of function library in
Excel sheet?
(a) Formal > Fﬁnqtion -
(b) Insert > Function

(¢) Formulas > Function

(d) View > Function |

(ii)
(iii)
(iv)
J’ (i), G, (iv)
(b) (ii), (iii), (iv)
() (), (i), (iii)
(d) @), (iit), (iv)
106. g v, TeRiel (MS Excel) #, THRE &1 HIwH

1°7wmmaémﬁﬁmqﬁm@aﬂﬁﬁ

Hﬁ‘q’fmm%? .

j) IS XU (Word Wrap) :

(b) gATH Qvts' SR (Bullets and Numbering)
(¢) wenfefT (Scéﬁng)

(d) SR ¥ & P T

108. gober e, § BT oty wd eI

WM

(@) Formal > Functio>n
(b) Ingert > Functidn
(¢) Formulas > Function .

(d) View > Function

[C]
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1 . :
09, Consider the following statements —

(T) Power Point lets you record and play macros.

(I) Power Point allows hyperlinks to extend
TESOurces. - ' ‘

(IIT) Keyboard shortcut}< ALT + F10 >is to exit
Power Point.

Select the correct statements from the code given
below -

(@) (I) and (IT)
(b) (T) and (1IT)

¢ (c) (II) and (11T)

110.

111.

(d) None of the abové

Which of the following is used to con’vert from

upper case to lower case and vice vérsa?

(@) Upper case

(b) Low'e_r case

(c) Sentence case

(d) Togg]e case 7

What is the work of a cookie?

(a) Stores software developed b)} the user |

(b) Stores the commands used by the user

(c) Stores information aboui the user’s web
-~ activity |

(d) Stores password of the usér :

112. A platform Where a person writes his opinions,

views and career advices is called -

(a) Blog

" (b) WhatsAPP
. () yYouTube

C]

(d) Google

109. fr=forRae ol W faarR &Y —

(I) UTR @Ee 3T Fsprar Rers F ok
AT B GfaeT <1 § |
(IT) TR @Tge STEuRfcie 1 TaweH! Bl fawr
& B gy dam | i
(D) FE AEHT < ALT +F10 > IR @ige
T IR e @ g 2
frmfotaa de & W woFl BT T B —

A8 (iR an

(b) (1) 3= (110)
(¢) (1) iR (1)
(o) SR ¥ 9 PE T

10. frfaRaa # & fHasT ISwa R 39 Bl

AR B § geoM IR 39 (Ui & @

(a) IR a‘ﬂw
(b) TR BH
(c) ¥icH DA

- F{DHI BT FT B 87

(a)mﬂamfmﬁmﬁwqaﬁmaﬁw%a
T B

ymﬂwﬁmwmnﬁmﬁ

Tufed ovar 2

(c)mﬁﬁawﬁrﬁﬁa%aﬁﬁaﬁm
gufed &ear 8 ‘

'(d)mﬁm“\‘i‘}%ﬁm%
12. 7 wiew el A Jo @, BRR W
. HdE Ud faR 9ee &R ®, wEendr € —

A = @log)

(b) EﬁE'HQU (WhatsApp)

(¢ W (YouTube)

(d) AT (Google)
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113. Gutter margin refers to 1

() Margin that is added to the binding side of
page when printing.

(b) Margin that is added to the outside of the

' bage when printing. : _

() Margin that is added to the left margin when
printing. .

(d) Margin that is addcdl.to right maréiri when
printing. ' il

114.If a website is developed using PHP, MySQL

and HTML, then what will be the type of website

developed?

(@) Static

(b) Dynamic

(¢) Flash

(d) None of these

115. Verification of a login name and password, is

13, e M &1 o 8 —
()memww$mﬁﬂqﬁ
‘jﬁmﬁami’l |
(o) A i T P T S B A S
ST B
'(c)mﬁqﬁwﬁﬁ-wmmﬁﬁﬁm
T 2
(@) TR S qET B EAE AR AR A
- Sirer W 2 |
114. 9f2 P1$ J9wse PHP, MySQL 3R HTML &1
Swin aRe Refid @ ol 8 @ e
JqIEE P USR T ENI? '
(a) Rfew
(b) TRIAE
(c) e - .
() T W P
115.ﬁﬁqmmm¢m@

known as - S w9 O o ¥
~ (a) Authentication A aﬁéﬁa}eﬁr
(b) Logging in (b) ST 39
-(€) Accessibility (c) TR
(d) Configuration (d) m ‘
116. What is an Operating System? 116, sireRfeT R @7 7
(a) Hardware i ' (a) TR
(b) Peripherals (b) TBIeg
(c) Application Software (c) TP TiremRr
(d) System Software \/(&')ﬁlwq divermw
TV L is a device to connect LAN to ~ 117-31 (LAN) &1 3T ¥ SIey @7 SuaRv
Internet. Mo PRI T 21 .
(a) Switch (a) R
(b) Bridge (b) firwt
(%) HTIE (©) TaE
(d) Router \/U*r
RIS
[C) Page 23 of 32




8.1, send the copy of an email to a new user is 118, §dgr a9 By T 44 YR B A9 B F7M

known as - HEA 87
(a) Bcc | (a) BCC
(b) Reply z 1 , (b) Reply
() cc \/(c)/cc
(d) Forward (d) Forward
119. Which option can be used to set custom timings  119. gyw. yrR @rEe UoieeE # wigs @ R
for slides in a MS Power Point presentation? T TEMAT e FR .Ef} forg f5 faden a1
(a) Slider Timings G'CI'!J’I'JTﬁTﬂT 4 W W
(b) Rehearse Timings : QT E’IE’WT
3 _ (b) Rewi ergfAT,
() Transition Duratlon% t/@'ﬂ'fﬁ;fm arafy
(d) None of these 8 _ (d) 379 | ®Ig 7Sl
120. Which icon is used toflzﬁd an attachment to an  120. $¥e7 # FdeT T @ forg fora amge &1
email? | | QuEnT fFa o €7 |
(a) Stationary icon . (@) R g
(b) Paperclip icon bl ) TIRfFeTY 3Ed
(¢) Emoji icon C‘u':)) (c) AT aTgHA
(d) None of these ‘30 (d) 378 I 318 T8

121. Which ‘one of the C?ollowmg is not an 121, ﬁﬂmﬁﬁﬁaﬂ?ﬁﬁﬁm/ﬂw% ISl
App/Website for botli train ticket and flight ¢4 fewe iR vame §ﬁb“T SF B W.

b—

book:ing in India? (@) feme g (Ticket new)
(a) Tlcket new % : (b) YT (redBus)
(b) redBus o
(c) Paytm ~ = el
@ Goibibo O (d) MET (Goibibo) e
122. A half completed email may be reserved for later  122- 3T gof %1 & w15 ¥ wurew aik RER 7@
editing and transmission to the receiver in AL I L Pieey # el
........................ folder. o) | T | 2| .
(a) Sent mail g (a) ¥T A
(b) Spam bin b . (b) ¥ i
(c) Inbox . (c) gTdie

(@ Dralt (d) 7‘&1/;-5%
il \
T i TR

C]




# @f B G
3. Which of the following is the best site for 123, fygaeprer & forw foyrrferfa wge

Encyclopedia? hﬁ%ﬁ 87
(8) Wikipedia (a) ﬁﬁ,—@@,’q‘[
(b) Google Jb) T
(c) Yz.ahoo Answers () g, aed %
(d) Bing (@ R (Bing) &3
124. What is the decimal equivalent of the binary 124. grg=i{ W& 10111“-3351 T ARG T 87
number 101117 (a) 42 . ( /Vag a
o (b) 21 i)
(b) e (° < L R
” L 23 A
w2 (d) 39 2
(d) 39 Oug

125. In Power Point, themes could be found under -
(a) Design Tab
(b) Insert Tab
(¢) Animation Tab

(d) None of the above

126.1f the send option for email is clicked without
writing anything in the subject field, which of the
following will happen? .
(a) Mail will be sent without any prompt.
(b) Mail will not be sent. .

(€) Mail will be sent by ﬁlhng the sub]ect ﬁeld
automatically.

(d) Prompt will appear on the screen to send the
mail without subject,

127.1n MS Excel, the cell reference for a range of

cells that starts in cell Al and goes over to E and
down to row 20 is -

el Vel B T ST B Riw et wad qar 27
(@) A1-E20 (@) A1-E20
(b) A1 : E20 9 Al:E20
(c) Al ; E20 (¢) Al ;E20
(d) A1.E20 (d) A1.E20
[ Page 25 of 32

125. qreR tang-d 4 mwﬁ@hemes) fpad aferfa o)

o ¥ ©
\/ﬁ)ﬁ',ﬁ_‘r@?-éﬂ
(b) 3=qd 29
() gfmee 29 :
() TR Y o

126. 3% fov ies $0ET A o R G4t @)
Tt & R TGP Rbar S 2 o fre
¥ | T grmre : '

(8) rer R Famll b B ol TR |
(b) %1 & A oA |

(c)mﬁam%%wﬁwwﬁﬁ%ﬁ
S| :

y@mﬁmw&;ﬂaﬁ%mmmm
(Prompt) g 3w :

127. T qH, oSl (MS Excel) ¥, ¥ Al ¥ IS 8H

arel 3R Bie B iR 99 R wfie 20 ao o

NN




'28. Which shortcut key is used to COpY and paste a
file folder? '
(8) Ctrl+C and Ctrl+V
(b) Ctrl+X and Ctrl+V
(€) Ctri+A and Curl+V
(d) Ctrl+Z and Ctrl+V

129. The order of files and directories in Windows

Explorer is -
(a) Sequentially
(b) Alphabetically
(¢) Hierarchically
(d) Serially

130.
shape?
(a) Triangle
(b) Oval
(c) Circle

(d) Diamond
131. What you will do in Power Point presentation to
use the exact same font type, size and color in the

title. of all the slides?

(a) Use file master
(b) Use slide master

(c) Use format brush and make tiﬂes identical

(d) None of the above

132. How many layers does OSI Model have?
(a) 10 '
(b) 7
(c) 6
(d) 5

Which of the. following is not a Power Point

123-'%%%&#3@_@?%@#&%
fore 59 wiicee gof &1 Suam féar s 87
& Curl+C 3R Curl+V
. (b) Curl+X 3R Curl+V
(¢) Ctrl+A 3R Ctrl+V
(d) Ctrl+Z 3R Ctrl+V
129. g TR ¥ wgall AR ARl @
wH B — .
(a) e w9 A
(b) quigeha A
- ) anfeg w5
(d) FHAFER
130ﬁmﬁrﬁaﬁﬁﬁzﬁﬂwwﬁwa@ﬁ
Tl 7
(a) BreproT
(b) JTESTHR
(e} g

JW@

131 3 U @rge JoieTd ¥ 1% S BiT TIR,

HZS Td Bk T ST B & forg Far s

S T wge @ AfE F e :
(8) BISel IR BT TANT TR

(©) Bife ¥e PT SUGNT RS NEBT B T

(d) TR ¥ W B T

132. g gEans. (OSD) Hisd Rl oRe (Iayers)

B 87
(a) 10
AD) 7
() 6
@ s

[C]
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LE 0D o ST L RO S function in MS Excel

represents the total number (s) of entries in the

cells.

(a) COUNT

(b) AVG /
(c) SUM

(d) TOTAL

B o b e s SRS is a program group.
(a) Paint '
(b) Word
(¢) Accessories
(d) None of these

135. Deleted emails are stored in -
(@) Draft
(b) Inbox
(c) Trash

(d) Outbox

136. I through email, someone asks you to reply with
sensitive information like credit card number
etc., which 'appearr; to be from a legiﬁmate
source, it is called as -
(a) Phishing
(b) Hacking
(c) Botnet
(d) Spamming
137. Which of the following pane is not available in
Task Pane?
(a) Getting started
(b) Clip Art
(c) Search Results
(d) Word Art

133, g, TR (MS Excel) F i
Wwﬁﬁmﬁmmﬁm

2|
(a) COUNT
(b) AVG

__(5) SUM
(d) TOTAL

..............................

136.9R a3 T ¥ B G
WFRI S ¥ Bre FaX e 3 |y Ik
< & forg w2, S fbed dy =i (Source)
L1 S B o A e
... T T R

o o
(b) BT
(c) e

\é,(d)ﬁﬁ'ﬂ

137. frfRea S 9 el wr O, m&qﬁm
T8t 8°?

(a)ﬁf%ﬂwr%@‘
(b) fd=g and
o) 5 Reteew
(d) 98 ae

......................................

IC]
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138, e key used to insert a link in MS Power Point  138. tqqwy. qrae @rge # YRy N uw fif :crlaﬁ

Presentation is - @ forg s Ll \_II'I%T .......................
(8) CTRL + K B
(b) CTRL +Q ' WR“ K,
() CTRL + N ol et
' _ (©CTRL+N
“) CTRL +D (d) CTRL + D
R The RrsE Gl A e bytes of MAC 139.3% (MAC) w4 o B et i
address is the address of ma_nufa'ctuygrv 6f ‘NIC ' EIETAG| T3S A (NIC) Eb‘ré P ﬁ‘ﬁ?ﬂ B T
card. il ; 2
(a) 4 j) 4
&) 2 (b) 2
(© 3 ©3
ds )5
140. Unsolicited email messages sent for commercial ~ 140- IN-SIHl ST ¥ TER 2g ‘ﬁ( K| s‘ﬁa GER
purposes is kno_wn as - ?fﬁ T BEd %7
(a) Gmail ‘ TR S ) o
(b) Reverse mail : | (b) Rasd ﬁa
(©) Bulk mail | , (c) 9o A
@) Spammail g \/w{@qﬁa B
141. The file that consists of readymade styles that we  141- 98 ®Tgel forem YEhrs diferit 21l & R Ll
can easily use for' presentation is known as - : SN Sl @ (o0 Sy 3 ‘HCRJT'T Y, S
o g, PEeldl § —
(a) Auto style (o)t orem
(b) Wizard (b) RS
(¢) Template (o) 2w
(d) Preformatting ' “ (d) shwiifeT

Page 3 o132 ATEEAw
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142

N

143.

144.

145,

Consider the following events and arrange these
in correct chronological order starting from the
earliest to last activity —

(D ARPA

(ID WWw

(IIT) Hypertext

(IV) TCP/IP

Select the correct option from the code given
below -

(a) (), (), (IV), (WD)
(b) (IV), (T, (1), (T)
(© @, V), (), (Im)
(d) (M, (O, (IV), (1)
What purpose do bookmarks serve?

(@) To use the document for search
(b) To save alignments as itis
(¢) Tosave a weBsite’s URL for future reference

(d) To save the document in a specific location

Which of the following operator can be used,
when we want to find a specific word and a
synonym for that word in Google Search engine?
(a) Tilde

(b) Minus

(¢) Quotations

(d) Period

What Power Point feature will you use to apply

motion effects to different objects of a slide?

142, g wremelt T R AT W TR

e} anfdt Iffafer @@ —

(I) ARPA

(ID WWW

(IIT) Hypertext

(IV) TCP/IP

A R T e A TE TR BT AGH DI —

(&) (I, (1), AV), (1)
(b) (Iv)v (m)’ (H)’ (D ; ‘

Y, av), am, (m

(d) am, (0, @), (1D

143 g fbw Sewm A off P &7
8 @ & foIY TwIEE BT ST HA B forg

(b) T BT AN & S W TE B

(0) wfisy & el & Ry et dewmse 3 g
RIS, P Taw B forg

(d) TXT P TF fafre WM W wRe @
ferg

144. 519 &1 T W o ¥ P AR e aik
IS [IEETE e TEe £ frefRad

A ¥ 59 ifRex &1 Syan fHar o gar 27
(@) e

(b) ATET

A BT

(d) difkgs

145 58 wgs & AR sfeiecd W 7y W
AL P B T o R ureR @iEe dRR @

(a) Slide Design ’ B‘q!fFT i
T 0 s e
\_yb Animation Objects ) welriver a‘iﬁﬂm
(¢) Slide Transition (©) TS TS
(d) Animation Scheme (d) WY w5
[C] Page 29 of 32
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B 146,

:1::0“; ‘i.n the MS Word document. | Qe B T o, qry |
(a) FI (@) F1
(b) F9 , 1 B
() Fi1 e A0 HL]
() F2 Y F2
147. 1P address in IPV6 is OF .................. koo it V7. PV HIP TR ... faea o & 2
bits. : (a) 64
(@) 64 | | (b) 32
(b) 32
(c) 128 : \/::))’ 128
(d) 16 . : : A ~
148. Which shortcut key is used to refresh Windows 148. fISrsr Swpely 3 Rubyr P R g
desktop? | - Aiche ol o1 ST Rbar oy 87
(a) F4 A - (@ F4 | :
(b) F5  MTF5 A g <
(c) F3 (c) F3 '
(d) F2 | (d) 2 : :
149 What is the full form of USB port? 149 4T0 AL W BT gewnt @ 27
(3) Universal Serial Bus ) I A g
(b) Universal System Bus ' : (b) Ffyarier Rreeq 99
(©) Uniform System Bus ©) IFor Ry 9
(d) Uniform Serial Bus ) I GiRae CEsl
150. Which one of the following group contains 150. for=ferRag ¥ fog TE 4 Mirea Blgdl
graphical file extensions? TFICTA wmfder 4
(a) JPG, CPX, GCM @ SRR, Do, et
(b) GIF, TCE, WMF ) NI, ARE, Seqores
A AV IR, o, dgd
() TCE. PG BMP DAMA, SRR, fomy
icl " Page 30 of 32
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